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Using the Technical Installation Guide 
The Secure Suite 4 MICROS 9700 Version 3 Technical Installation Guide provides detailed information on installing 
its files and configuring various components of the MICROS 9700 application for use with Secure Suite 4 MICROS 
9700. 

It is important to note that this guide is used for all subsequent versions of MICROS 9700 Version 3. While the basic 
installation and configuration remains the same throughout all versions, variances in MICROS’ screen designs may 
appear and include additional options; however, these options are not relevant to the installation and 
configuration of Secure Suite 4 MICROS 9700. 

In addition, Secure Suite 4 MICROS 9700 operates with Windows 2000 and 2003. 

 

Who Should Use This Guide? 
This guide is intended for individuals familiar with installing, programming, configuring, and updating the MICROS 
9700 system, such as:  

• MICROS Programmers/Installers 

• MICROS Dealers 
• MICROS Customer Service Representatives 
• MICROS Training Personnel 
• MIS/IT Personnel 

This guide assumes that the installer has the following knowledge or expertise: 

• Operational understanding of PCs 
• Understanding of basic network concepts 
• Experience with Microsoft Windows operating systems 
• Understanding of Point-of-Sale (POS) terminology and concepts 

• Exposure to MICROS POS systems (8700, 9700, 3700, or other MICROS POS systems) and familiarity with 
associated peripherals 

 

Security and Secure Suite 4 MICROS 
To ensure the Secure Suite 4 MICROS is installed, configured, and operating in a secure manner and environment 
that is compliant with PCI DSS standards, you must read the following documents: 

• MICROS 3700 or 9700 PA-DSS Implementation Guide 
• Secure Suite 4 Micros 9700 Version 3 Technical Installation Guide 
• The latest version of the PCI DSS documentation at www.pcisecuritystandards.org 

 

 

http://www.pcisecuritystandards.org/
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WARNING! For security implementation and best practices, see the 
Secure Suite 4 MICROS 3700 or 9700 PA-DSS Implementation Guide. 

  

Use of a Payment Application Data Security Standard (PA-DSS) compliant application by itself does not make an 
entity PCI DSS compliant, since that application must be implemented into a PCI DSS compliant environment and 
according to the PA-DSS Implementation Guide provided by the payment application vendor.  

All applications that store, process, or transmit cardholder data are in scope for an entity’s PCI DSS assessment, 
including applications that have been validated to PA-DSS. The PCI DSS assessment should verify the PA-DSS 
validated payment application is properly configured and securely implemented per PCI DSS requirements and the 
vendor’s PA-DSS implementation guide. If the payment application has undergone any customization, a more in-
depth review will be required during the PCI DSS assessment, as the application may no longer be representative 
of the version that was validated to PA-DSS.  

The PA-DSS requirements are derived from the PCI DSS Requirements and Security Assessment Procedures (defined 
in this document). The PA-DSS details the requirements a payment application must meet in order to facilitate a 
customer’s PCI DSS compliance. As security threats are constantly evolving, applications that are no longer 
supported by the vendor (e.g., identified by the vendor as “end of life”) may not offer the same level of security as 
supported versions. 

 

Installation and Configuration Essentials 
A reference list and an installation checklist are included below to ensure the Secure Suite 4 MICROS 9700 
installation and configuration processes run smoothly. 

The reference list is a companion to the parameter file and includes space to record numbers that may be assigned 
during the configuration process. In addition, details on the reference list may be collected prior to the 
configuration process to create the parameter file in advance. 

The installation checklist is a companion to the installation guide and guarantees all required steps are completed. 
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Reference List 
Print and use this reference list throughout the configuration process to record details that you will need to 
reference later. The table contains entries you may or may not need. Contact the Shift4 Payments Customer 
Support team at 702.597.2480, option 2, with any questions. 

 

Name Details 

MICROS Version Number   

MICROS Server Name  

MICROS Server IP Address  

CaDOTN Interface Number   

CaDOTN TCP Port Number Default: 8797 

MicrosTCP Interface IP Address  

MicrosTCP Port Number Default: 17478 

4GoTCP Interface IP Address  

4GoTCP Port Number Default: 17504 

Merchant Name/Type, Shift4 Payments Merchant ID, Assigned RVC Name/Number 

 

Merchant Name/Type, Shift4 Payments Merchant ID, Assigned RVC Name/Number 

 

Merchant Name/Type, Shift4 Payments Merchant ID, Assigned RVC Name/Number 

  

Charged Tip Service Charge Number  

Charged Tip Active? Yes or No 

Cash Tender Media Number  

Visa Tender Media Number  

MasterCard Tender Media Number  
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Name Details 

Discover Tender Media Number  

American Express Tender Media Number  

Diners Club Tender Media Number  

Japanese Credit Bureau Tender Media Number  

Gift Card Tender Media Number  

Alt. Gift Card Preamble Number  

GC SALE Service Charge Number  

GC RECHARGE Service Charge Number  

GC CASHOUT Service Charge Number  

Employee Class Name/Number  

Employee Class Name/Number  

Employee Class Name/Number  

 

Installation Checklist 
Print and use this checklist throughout the configuration process to ensure Secure Suite 4 MICROS 9700 is properly 
installed and configured. Contact the Shift4 Payments Customer Support team at 702.597.2480, option 2, with any 
questions. 

1. Installing and Configuring Secure Suite 4 MICROS 9700 

 Prior to Installation  

 Prepare to Install Secure Suite 4 MICROS 9700 

 Install Secure Suite 4 MICROS 9700 

 Configure the UTG to Communicate with Secure Suite 4 MICROS 9700 
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 Verifying File Placement 

 Verifying File Placement for 4 Way Stop (if configured) 

Configuring the MICROS Terminals 

2. MICROS System Configuration 

System Hardware Settings 

System Information Settings 

RVC Information Settings 

Touchscreen Settings 

Parameter File Settings 

Shared Secret Passphrase Settings 

3. (Optional) Gift Card Configuration 

Steps 1 and 2 above Completed 

System Information Settings  

Personnel Settings  

Touchscreen Settings  

Parameter File Settings  

4. Post-Installation Process 

Restarting the MICROS 9700 System 

Verifying the CaDOTN.log File 

Activating the MICROS Terminals 

Running a Test Transaction 
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Installing and Configuring Secure Suite 4 MICROS 9700 
This section explains how to install Shift4 Payments’ Secure Suite 4 MICROS 9700 and configure it to communicate 
with Shift4 Payments’ Universal Transaction Gateway® (UTG®). 

Prior to Installation 
Before installing Secure Suite 4 MICROS 9700, you must verify the MICROS 9700 system has been set up and 
tested, settle any outstanding batches, verify the UTG is installed on the same network as the MICROS server and 
terminals, and lastly, download the Secure Suite 4 MICROS 9700 installer. 

Verifying the MICROS System 
You must verify the MICROS 9700 system has been set up and tested prior to installing Secure Suite 4 MICROS 
9700: 

• All credit card types accepted must be set up and tested. 
• If charged tips are accepted, service charges for charged tips must be set up and tested. 
• If MICROS Keyboard Workstation 270 is in use, complete the “Keyboard Overlay for the MICROS Keyboard 

Workstation 270” section. 

Keyboard Overlay for the MICROS Keyboard Workstation 270 

Secure Suite 4 MICROS 9700’s CaDOTN driver is designed to accept the manual entry of a payment card number 
when the Mag Card Reader on the MICROS Keyboard Workstation 270 is unable to read the swiped payment card.  

Upon completion of installing Secure Suite 4 MICROS 9700, five hard coded keys on the keyboard are remapped to 
ensure proper functionality when entering a payment card number manually on the keyboard – all other keys are 
at the merchant’s discretion. The five hard coded keys on the keyboard are remapped to the following:  

 

Hard Coded Key  Remapped Key 

X 
Enter 

Yes 

Y 
Clear 

No 

– 

- 
0 

) 

0 
. 
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Hard Coded Key  Remapped Key 

+ 

= 
00 

 

To ensure proper placement of the keypad on the keyboard, which will ensure the CaDOTN driver accepts the 
number as entered, a paper overlay will be needed – the design is based on MICROS’ standard keypad layout.  

 

Please use the layout below: 
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WARNING! Do NOT proceed with the Secure Suite 4 MICROS 9700 
installation until your MICROS System is set up and tested. 

 

Settling Batches 
Prior to installing Secure Suite 4 MICROS 9700, customers must settle any outstanding batches either by running 
the MICROS 9700 Batch Auto Sequencer or by executing the company’s normal settlement process.  

The MICROS 9700 Batch Auto Sequencer is configured to automatically run reports and archive them as part of the 
Batch Auto Sequencer process. Customers can run the Credit Card Report from the MICROS 9700 EMC to confirm 
that all batches were settled. 

 

 

WARNING! Settle any outstanding batches before installing Secure Suite 
4 MICROS 9700 to prevent loss of information. Once installation is 
complete, you will no longer be able to settle batches with transactions 
that were processed prior to its installation. 

 

Verifying the UTG Installation 
Prior to installing Secure Suite 4 MICROS 9700, you must verify that the UTG is installed on the same network as 
the MICROS server and terminals. A UTG must be on the MICROS network in order for 4Go® to function properly. 
Make any necessary changes to the UTG installation before proceeding with the Secure Suite 4 MICROS 9700 
installation. 
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Prepare to Install Secure Suite 4 MICROS 9700 
To prepare for installation, perform the following steps: 

1. From the Start menu, select Programs > MICROS Applications > EMC. 

2. In the MICROS 9700 Server Selector window, select or type the name of the server and click Connect. 

 

 
 

3. In the Login to 9700 Server window, the merchant will perform the following: 

 

 
 

• In the User box, the merchant types their MICROS 9700 ID. 
• In the Password box, the merchant types their MICROS 9700 password. 
• Click Login. 
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4. In the EMC window, under SYSTEM, select Control Panel. Under Control, verify Workstation Operations 
is selected, indicating the MICROS terminals are currently activated. 

 

 
 

5. To stop operations and deactivate the terminals, perform the following steps: 

 

 
 

• Under Control, select Server Applications. 

• When the system prompts Stop 9700 Ops?, click Yes. 
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• Under Message, verify the message Operations stopped appears. 

6. The Secure Suite 4 MICROS 9700 Installer file located at 
www.shift4.com/downloads/securesuite4micros9700.exe should be downloaded and saved to the 
desktop. Double-click the securesuite4micros9700.exe file on the desktop to open Shift4 Payments’ 
Installation Wizard. 

http://www.shift4.com/downloads/securesuite4micros9700.exe
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Install Secure Suite 4 MICROS 9700 
The Installation Wizard provided by Shift4 Payments identifies system configuration parameters and installs files in 
their appropriate locations. 

 

In addition, the Installation Wizard provides an option to install the Secure Suite 4 MICROS 9700 4Go Terminal 
Client, also called “4 Way Stop,” on the server – this allows the server to be used as a MICROS terminal in which 
transactions may be processed on.  

 

To install Secure Suite 4 MICROS 9700, perform the following steps: 

1. In the Installation Wizard window, click Next to continue the installation. 

2. Read the license agreement, scroll to the bottom to indicate acceptance, and click Next to continue.  

3. The Installation Wizard is ready to make changes to your computer. Click Next to continue. 

4. The Installation Wizard displays a message regarding using the MICROS Server as a terminal, select Yes or 
No as applicable. 

5. The Installation Wizard shows the progress of the installation: 

6. The Installation Wizard displays a message indicating the process was successful. Click Finish. 
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Configure the UTG to Communicate with Secure Suite 4 MICROS 9700 
Prior to configuring settings in the MICROS 9700 system, you must configure TCP/IP interfaces in the UTG to 
communicate with Secure Suite 4 MICROS 9700, which consists of the following three sections: 

• Configuring the UTG to Communicate with the CaDOTN Driver  
• Configuring the UTG to Communicate with the MICROS Terminals 

• Configuring the UTG for the 4Go interface 

 

 

Requirement: You must use a different TCP/IP interface for the CaDOTN 
driver communication and the MICROS terminal communication. 

 

Configuring the UTG to Communicate with the CaDOTN Driver 
To configure the UTG to communicate with the CaDOTN driver via a TCP/IP interface, perform the following steps: 

1. If the UTG is running as a service, stop the service: 

• From the Start menu, select Programs > Administrative Tools > Services. 
• Locate Shift4 UTG(v2), right-click and select Stop. 

2. If the UTG is running in Stand Alone, close it: 

• In the UTG Task Explorer window, click Close (red X). 
• On the Shutdown Shift4’s Universal Transaction Gateway screen, select Yes. 
• The UTG Task Explorer window will show a shutdown countdown and then close. 

3. From the Start menu, select Programs > Shift4 Corporation > Universal Transaction Gateway > UTG (v2) 
TuneUp. 
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4. In the UTG TuneUp window, verify the Api Interfaces tab is selected. Under Interface, click Add, and 
select TCP/IP. 

 

 
 

5. In the TCP/IP API window, configure the following: 

 

 
 

• In the Task Description box, type MicrosTCP. 
• From the Host Address list, select the MICROS Server IP Address; or, if the UTG is on a 

different computer than the MICROS server, when configuring the UTG you must select the 
IP address that can communicate to the MICROS server. 



 Secure Suite 4 MICROS 9700 Version 3 
Technical Installation Guide 

© 2019 Shift4 Payments, LLC. All rights reserved. Version 1.7 
External Use NDA Page 17 of 130 

o Record the IP address you selected, which will be the MicrosTCP Interface IP 
Address on your reference list, you will need it later. 

• In the Port box, type the default 17478 ($4446 for hex) unless it is in use by another TCP/IP 
API. If you use a port other than 17478, record the port number on your reference list, you 
will need it later.  

• In the Encryption Passphrase box, type the shared secret passphrase (which is case 
sensitive) for communication between the UTG and the CaDOTN driver. 

• In the Verify Passphrase box, type the same passphrase. 
• Select Bin Management or Stand In if needed. The default is to leave the boxes cleared. 

6. Click Clients and follow the instructions below to add the CaDOTN driver as a client of the MicrosTCP 
interface. 
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Adding the CaDOTN Driver as a Client of MicrosTCP 

To add the CaDOTN driver as a client of the MicrosTCP interface, perform the following steps: 

1. In the Edit Client IP List for TcpHost window, click Add. 

 

 
 

2. In the Add Client IP Address window, add the CaDOTN driver to the client list: 

 

 
 

• In the Remote IP Address box, type the MICROS Server IP Address. 
• In the Interface Type list, select Secure POS Only. 
• Click OK. 

3. In the Edit Client IP List for MicrosTCP window, click OK. 

4. In the TCP/IP API window, click OK. 

5. Leave UTG TuneUp open and continue with “Configuring the UTG to Communicate with the MICROS 
Terminals.” 
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Configuring the UTG to Communicate with the MICROS Terminals 
 

 

Requirement: The TCP/IP interface for MICROS terminal communication 
must not use a passphrase. If in addition to Secure Suite 4 MICROS 9700 
you are also using POSibridge or a similar application, set up a separate 
TCP/IP interface that does use a passphrase for that application. 

 

To configure the UTG to communicate with the MICROS terminals via a TCP/IP interface, perform the following 
steps: 

1. In the UTG TuneUp window, verify the Api Interfaces tab is selected. Under Interface, click Add, and 
select TCP/IP. 
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2. In the TCP/IP API window, configure the following: 

 

 
 

• In the Task Description box, type 4GoTCP. 
• From the Host Address list, select the MICROS Server IP Address; or, if the UTG is on a 

different computer than the MICROS server, when configuring the UTG you must select the 
IP address that can communicate to the MICROS terminals. 

o Record the IP address you selected, which will be the 4GoTCP Interface IP Address 
on your reference list, you will need it later. 

• In the Port box, type the default 17504 ($4460 for hex) unless it is in use by another TCP/IP 
API. If you use a port other than the suggested port, record the port number on your 
reference list, you will need it later. 

 

 

Requirement: Do not use the same port number for the MICROS terminal 
communication as you used for the CaDOTN driver. 

 

• Leave the Encryption Passphrase box blank. 
• Leave the Verify Passphrase box blank. 

• Clear Bin Management and Stand In if selected. 

 

3. Click Clients and follow the instructions below for “Adding Terminals to 4GoTCP” (for a small number of 
terminals needing to be added) or “Importing Terminals to 4GoTCP” (for a large number of terminals 
needing to be added). 
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Adding Terminals to 4GoTCP 

When you have a small number of MICROS terminals, you can add each terminal individually. 

To add terminals to the 4GoTCP interface, perform the following steps: 

1. In the Edit Client IP List for TcpHost window, click Add. 

 

 
 

2. In the Add Client IP Address window, add the MICROS terminal to the client list: 

 

 
 

• In the Remote IP Address box, type the MICROS Terminal IP Address. 
• In the Interface Type list, select 4Go. 
• Click OK. 

3. Repeat Steps 1 and 2 for each MICROS terminal. 

4. In the Edit Client IP List window, click OK to save the client IP list. 

5. In the TCP/IP API window, click OK. 

6. Continue with “Configuring the UTG for the 4Go Interface.” 
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Importing Terminals to 4GoTCP 

When you have a large number of MICROS terminals, the fastest way to add them to the 4GoTCP interface is to 
import the IP addresses from a file. 

 

 

Requirement: The import file must be a text (.txt) file and must contain 
only one IP address per line. 

 

To import terminals to the 4GoTCP interface, perform the following steps: 

1. In the Edit Client IP List for TcpHost window, click Import. 

 

 
 

2. In the Open window, browse to and select the .txt file that contains the MICROS terminal IP addresses, 
and click OK. 

3. In the Select Interface Type window, specify the interface type for all of the imported terminals: 
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• Select 4Go. 
• Click OK. 

4. In the Edit Client IP List window, click OK to save the client IP list. 

5. In the TCP/IP API window, click OK. 

6. Continue with “Configuring the UTG for the 4Go Interface.” 

 

Configuring the UTG for the 4Go Interface 
The 4Go interface intercepts credit card data so that no cardholder data is stored in the MICROS 9700 system at 
the merchant level.  

To configure the UTG for the 4Go interface, perform the following steps: 

1. In the UTG TuneUp window, click the 4Go tab and configure the following settings: 

 

 
 

• Select Enabled. 
• Under Broadcast Addresses, select the IP Address that is used to communicate to the 

MICROS Server and Terminals.  

• Under Faux Generation Method, select the default Sequential - Valid Luhn Mod 10.  
• Under Retention Time, select retention times for Normal (default is 5) and Offline (default is 

30) modes. 
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• Under Update Server, leave Host Address and Port blank. 

 

2. Click Save. 

3. Restart the UTG service: 
• As a service, from the Start menu, select Programs > Administrative Tools > Services. Locate 

Shift4 UTG(v2), right-click and select Start. 

• In Stand Alone, from the Start menu, select Programs > Shift4 Corporation > Universal 
Transaction Gateway > UTG (v2) Stand Alone.  

 

Run the Shift4 4Go Configuration Utility 

1. From the Start menu, select Programs > Shift4 Corporation > Secure Suite 4 MICROS 9700 > Shift4 4Go 
Configuration Utility. 

2. In the Enter Unique Code window, follow the instructions to obtain a response code from a Shift4 
Payments Customer Service Representative (CSR), type the code in the Response Code box, and click 
Submit. 
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3. In the 4Go Configuration & Setup window, on the UTG Configuration tab, under UTG2 (1) Configuration, 
configure the following: 

• In the IP Address box: 

o Type the 4GoTCP Interface IP Address from your reference list. 

 

 

Requirement: If your IP address has less than three digits in a portion, 
you must type the decimal point. If there are three digits in the portion, 
the decimal point will automatically be added for you. Visually verify 
correct upon completion of typing the IP address. 

 

• In the Port Number box: 
o Type the 4GoTCP Port Number from your reference list. 
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4. Click the POS Configuration tab to continue the configuration. 

• The settings on the POS Configuration tab defaults to the MICROS version. Do not change 
any of the default settings except for the Password. 

 

 
 

• (Default) Win Class: 8700APP  

• (Default) Win Name: MICROS PCWS Operations 
• (Default) Include SAR Configuration is selected 
• (Default) SAR Win Class: 97000PSAPP 
• (Default) SAR Win Name: 97000PSAPP 
• (Default) Exclusion: 0 
• Password: Type 1234 to proceed with the installation. This password will not be used by the 

system after installation. 

5. Under Custom Strings, click Create and when the system warns about overwriting the Strings.Ini file, click 
OK to confirm that you want to continue. 
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6. Click the Swipe Configuration tab and configure the information that the system prompts for when the 
card is swiped: 

 

 
 

• Do not change the Required Tracks or Manual Entry Returned settings. They default based 
on the MICROS version. For MICROS 9700, both default to Track 2 Only. 

• (Optional) Select Prompt for Card Security Cd to prompt for the unique 3- or 4-digit Card 
Verification Value on the back of the debit or credit card, which is also called the Card 
Security Code (confirm with merchant if needed). 

• (Optional) Select Prompt for Zipcode to prompt for the postal code (confirm with merchant 
if needed). 

• (Optional) Select Prompt for House Number to prompt for the number of the street address. 
For example, if the street address is 123 Main Street, then “123” is the House Number 
(confirm with merchant if needed). 

• (Optional) Select Enable P2P Encryption to enable Point-to-Point Encryption; and from the 
Device Type list, select your MSR device type. 
o When P2PE is enabled, payment cards should be swiped on the P2PE device; non-

payment cards should be swiped on the MICROS terminal. 
o When P2PE is enabled, the Manual Entry Options are not configurable because the 

device can be configured to prompt for the information: 
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• (Optional) In the Manual Entry Name box, type the name that will be printed on receipts for 
manually entered transactions. The default is MANUAL/ENTRY. 

 

CAL Setup (Logging and Tuning Settings) 

For new installations, perform the following steps: 

1. Click the CAL Setup tab. 

2. Click Select All in the Push Setup column and the Push Strings.ini column. 

3. Click Save and Close. 
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Configure or Reconfigure a Terminal Type Individually 

If needed, perform the following steps: 

1. Click the CAL Setup tab. Click the Setup button opposite the terminal type you need to configure. 
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2. In the Additional Setup window of your selected terminal, confirm that Log Enabled is blank to disable 
Logging, and then confirm the default Tuning settings against the table that follows: 

 

 
 

Pause Setting Net 
Setup WS4 WS4LX WS5 WS5A CE 

WS5A 

POSReady 2009 
Win32 

Systems 

Pre-Injection 250 150 150 150 150 250 250 

Keying 10 10 10 10 10 10 10 

Auxiliary 100 5 5 5 5 10 100 
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3. Click OK to return to the CAL Setup tab. 

 

 
 

4. Repeat Steps 1, 2, and 3 for each terminal type in use. For every terminal configured, the Push Setup 
check box is selected automatically. 

5. Click Save and Close. 
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Verifying File Placement 
After configuring Secure Suite 4 MICROS 9700, verify the following files are found in the corresponding folders; if 
they are not, contact Shift4 Payments. 

 

 

Note: File placement for WS5A only applies to versions 3.1, 3.2, and 3.5 
with patches supplied by MICROS. 

File placement for WS5A applies to version 3.6 without a patch supplied 
by MICROS. 

File placement for KW270 only applies to version 3.6 for SAR terminals. 

 

...Micros\LES\POS\9700\bin\ 

CaDOTN.exe 

s4cedStart.dll 

s4Crypto.dll 

s4GoConfig.exe 

S4PasswordUtil.exe 

ShredAndDelete.exe 

 

...Micros\LES\POS\9700\Etc\ 

CaDOTN.isl 

CaDOTN.param 

CaDOTNReadMe.txt 

SQLEMP.bat 

SQLEMPNO.bat 

FourGoDEC.cfg 

Strings.ini 

 

...Micros\LES\POS\9700\Scripts\SAR 

CaDOTN.isl 

 

...Micros\LES\POS\9700\ClientInstalls\CALInstall\Win32\Packages\Shift4 4Go 

S4WayStopSetup.exe 

setup.dat 
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...Micros\LES\POS\9700\ClientInstalls\CALInstall\WS4\Packages\Shift4 4Go 

...Micros\LES\POS\9700\ClientInstalls\CALInstall\WS4LX\Packages\Shift4 4Go 

...Micros\LES\POS\9700\ClientInstalls\CALInstall\WS5\Packages\Shift4 4Go 

...Micros\LES\POS\9700\ClientInstalls\CALInstall\WS5A\Packages\Shift4 4Go 

FourGoDCE.exe 

S4WayStopCE.exe 

setup.dat 

 

\MICROS\LES\POS\9700\ClientInstalls\CALInstall\Win32\Files\Shift4\Param 

\MICROS\LES\POS\9700\ClientInstalls\CALInstall\WS4\Files\CF\PosClient\Sim 

\MICROS\LES\POS\9700\ClientInstalls\CALInstall\WS4LX\Files\CF\PosClient\Sim 

\MICROS\LES\POS\9700\ClientInstalls\CALInstall\WS5\Files\CF\PosClient\Sim 

\MICROS\LES\POS\9700\ClientInstalls\CALInstall\WS5A\Files\CF\PosClient\Sim 

\MICROS\LES\POS\9700\ClientInstalls\CALInstall\KW270\Files\Store\PosClient\Sim 

CaDOTN.param 

 

\MICROS\LES\POS\9700\ClientInstalls\CALInstall\Win32\Packages\Shift4 4Go SAR 

S4WayStopSetup.exe 

setup.dat 

 

\MICROS\LES\POS\9700\ClientInstalls\CALInstall\WS4\Packages\Shift4 4Go SAR 

\MICROS\LES\POS\9700\ClientInstalls\CALInstall\WS4LX\Packages\Shift4 4Go SAR 

\MICROS\LES\POS\9700\ClientInstalls\CALInstall\WS5\Packages\Shift4 4Go SAR 

\MICROS\LES\POS\9700\ClientInstalls\CALInstall\WS5A\Packages\Shift4 4Go SAR 

\MICROS\LES\POS\9700\ClientInstalls\CALInstall\KW270\Packages\Shift4 4Go SAR 

FourGoDCE.exe 

S4cedStart.dll 

S4WayStopCE.exe 

setup.dat 

 

...Micros\LES\POS\9700\ClientInstalls\CALInstall\Win32\Files\Shift4\4Go\etc 

...Micros\LES\POS\9700\ClientInstalls\CALInstall\WS4\Files\CF\Micros\etc 
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...Micros\LES\POS\9700\ClientInstalls\CALInstall\WS4LX\Files\CF\Micros\etc 

...Micros\LES\POS\9700\ClientInstalls\CALInstall\WS5\Files\CF\Micros\etc 

...Micros\LES\POS\9700\ClientInstalls\CALInstall\WS5A\Files\CF\Micros\etc 

...Micros\LES\POS\9700\ClientInstalls\CALInstall\KW270\Files\Store\Micros\etc 

FourGoDCE.cfg 

Strings.ini 

 

Verifying File Placement for 4 Way Stop 
If the server is also being used as a MICROS terminal, in addition to the files listed above, the following file should 
be present when 4 Way Stop is properly installed on the server: 

 

...Shift4\4Go\Bin 

S4SecurePayment.dll 

S4WayStop.exe 

 

...Shift4\4Go\etc 

FourGoDCE.cfg 

Strings.ini 
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Configuring the MICROS Terminals 
At this point, Secure Suite 4 MICROS 9700 has been installed and configured on the server. The option to use the 
server as a MICROS terminal, utilizing 4 Way Stop, may have been selected during the Secure Suite 4 MICROS 9700 
installation on the server as well.  

 

Now, Secure Suite 4 MICROS 9700 and 4 Way Stop will need to be installed and configured on the remaining 
MICROS terminals. Operations must be minimized on each MICROS terminal before Secure Suite 4 MICROS 9700 
and 4 Way Stop can be installed. For assistance in minimizing operations, please contact the Shift4 Payments 
Customer Support team at 702.597.2480, option 2.  

The installation process varies based on whether the terminals are Stand Alone Resiliency (SAR) terminals 
with/without CAL installed or Non-SAR terminals with/without CAL installed – follow the applicable instructions: 

• Installing Secure Suite 4 MICROS 9700 on SAR Terminals with CAL 
• Installing Secure Suite 4 MICROS 9700 on SAR Terminals without CAL 
• Installing Secure Suite 4 MICROS 9700 on Non-SAR Terminals with CAL 
• Installing Secure Suite 4 MICROS 9700 on Non-SAR Terminals without CAL 

 

Limitations of Running as a SAR Terminal 
The following limitations apply when running as a SAR terminal: 

• No initial authorizations (no tabs). 
• No incremental authorizations. 
• No multiple authorizations on one check (no split or partial tenders with more than one credit card). 
• No adjusting a closed check to another credit card. 
• No filtering of seats. 
• No gift card functions for MICROS 9700 3.2 or 3.5. 

 

Limitations of Running on a Win32 Terminal 
The following limitation applies when installing and running on Win32 Terminals (Eclipse 2010, 2015, 5A POSReady 
2009, or a Desktop PC based workstation): 

• The default auto user login must have administrator rights granted in order to install and run Secure Suite 
4 MICROS 9700 and 4 Way Stop. If the default auto user login does not have administrator rights, 4 Way 
Stop will not function properly upon reboot.  
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Installing Secure Suite 4 MICROS 9700 on SAR Terminals with CAL 
The Secure Suite 4 MICROS 9700 installation integrates with the MICROS CAL application. To install, perform the 
following steps on each SAR terminal with CAL installed: 

1. On the MICROS terminal, minimize operations. 

2. On the MICROS terminal, from the Start menu, select Programs > CAL > Reconfigure CAL. Wait for the 
MICROS Cal Busy... window to close which indicates MICROS CAL has located a server running the CAL 
service. 

3. In the MICROS CAL – Select CAL Server window, verify CAL Enabled is selected. 

4. In the MICROS CAL - Select CAL Server window, under Available Servers, select the MICROS 9700 server 
from the list and click Next. 
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5. In the MICROS CAL – Select WS Identity window:  

 

 
 

• In the Select Product to Install on Workstation list, select Shift4 4Go SAR to install Secure 
Suite 4 MICROS 9700 and 4 Way Stop simultaneously. (If the version of CAL on the 
workstation is older than the version of CAL on the server, CAL updates and reboots the 
workstation before installing Secure Suite 4 MICROS 9700 and 4 Way Stop.) 

• Click Save. 

6. After Secure Suite 4 MICROS 9700 and 4 Way Stop are finished being installed on the terminal, the 
terminal will restart the winstation application. (4 Way Stop may start after the winstation application and 
reside in the foreground – press anywhere behind 4 Way Stop to bring winstation to the foreground.) 
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7. After Secure Suite 4 MICROS 9700 and 4 Way Stop are installed on the terminal, the following files should 
be present: 

 
Win32 

…Shift4\4Go\Bin 

• S4SecurePayment.dll 
• S4WayStop.exe 

...Shift4\4Go\etc 

• FourGoDCE.cfg 
• Strings.ini 

…\Program Files\Micros\PosClient\Sim 

• ScriptX.isl, where X equals the CaDOTN interface number. 
 
WS4, WS4LX, WS5, or WS5A 

…CF\Micros\Bin 

• FourGoDCE.exe 
• S4WayStopCE.exe 

...CF\Micros\etc 

• FourGoDCE.cfg 
• Strings.ini 

...CF\PosClient\Bin 

• S4cedStart.dll 
…CF\PosClient\Sim 

• ScriptX.isl, where X equals the CaDOTN interface number. 
 
KW270 

…Store\Micros\Bin 
• FourGoDCE.exe 

• S4WayStopCE.exe 
...Store\Micros\etc 

• FourGoDCE.cfg 

• Strings.ini 
...Store\PosClient\Bin 

• S4cedStart.dll 
…Store\PosClient\Sim 

• ScriptX.isl, where X equals the CaDOTN interface number. 

 

8. Repeat Steps 1, 2, 3, 4, and 5 on each SAR terminal with CAL as required. 
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Installing Secure Suite 4 MICROS 9700 on SAR Terminals without CAL 
If the terminal is a Win32 (Eclipse 2010, 2015, 5A POSReady 2009, or a Desktop PC based workstation) and does 
not have the MICROS CAL application installed, Secure Suite 4 MICROS 9700 and 4 Way Stop can still be installed. 

To install Secure Suite 4 MICROS 9700 and 4 Way Stop, perform the following steps on each SAR terminal without 
CAL installed: 

1. Log on to the terminal without CAL as Administrator. 

2. Copy the S4WayStopSetup.exe file from the following directory on the server 
...ClientInstalls\CALInstall\Win32\Packages\Shift4 4Go SAR and paste it on the terminal’s desktop. 

3. Copy the Shift4 folder from \MICROS\LES\POS\9700\ClientInstalls\CALInstall\Win32\Files and paste it 
in the terminal’s C:\ drive.  

4. Verify the following file placements: 

C:\Shift4\4Go\bin 

• No files (empty) 

C:\Shift4\4Go\etc  

• FourGoDCE.cfg 

• Strings.ini 

C:\Shift4\Param 

• CaDOTN.param 

5. On the terminal’s desktop, double-tap S4WayStopSetup.exe to run the 4 Way Stop installer. 
• After 4 Way Stop is installed on the terminal, the following files should be present: 

C:\Shift4\4Go\bin 
• S4SecurePayment.dll 
• S4WayStop.exe 

6. Repeat Steps 1, 2, 3, 4, and 5 on each SAR terminal without CAL as required. 

7. Read “Rebooting Terminals without CAL” which contains important information about rebooting these 
terminals once Secure Suite 4 MICROS 9700 and 4 Way Stop have been installed. 

Rebooting Terminals without CAL 

Anytime a terminal without CAL is rebooted once Secure Suite 4 MICROS 9700 and 4 Way Stop have been installed, 
the terminal’s user must tap the 4Go application window on the terminal to give the 4Go window focus.  

If the user fails to tap the 4Go application window after rebooting, the following error will occur the next time a 
card is swiped on the terminal: Entry error - Please retry - 4Go. To recover from this error message, perform the 
following steps on the terminal: 

1. On the 4Go window, tap the Cancel button. 

2. Tap the Clear button to clear the error message. 

3. On the Touchscreen, tap the CCard Auth button. 

4. Finish the card transaction as usual. 
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Installing Secure Suite 4 MICROS 9700 on Non-SAR Terminals with CAL 
The Secure Suite 4 MICROS 9700 installation integrates with the MICROS CAL application. To install, perform the 
following steps on each Non-SAR terminal with CAL installed: 

1. On the MICROS terminal, minimize operations. 

2. On the MICROS terminal, from the Start menu, select Programs > CAL > Reconfigure CAL. Wait for the 
MICROS Cal Busy... window to close which indicates MICROS CAL has located a server running the CAL 
service. 

3. In the MICROS CAL – Select CAL Server window, verify CAL Enabled is selected. 

4. In the MICROS CAL - Select CAL Server window, under Available Servers, select the MICROS 9700 server 
from the list and click Next. 
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5. In the MICROS CAL – Select WS Identity window:  

 

 
 

• In the Select Product to Install on Workstation list, select Shift4 4Go to install Secure Suite 4 
MICROS 9700 and 4 Way Stop simultaneously. (If the version of CAL on the workstation is 
older than the version of CAL on the server, CAL updates and reboots the workstation before 
installing Secure Suite 4 MICROS 9700 and 4 Way Stop.) 

• Click Save. 

6. After Secure Suite 4 MICROS 9700 and 4 Way Stop are finished being installed on the terminal, the 
terminal will restart the winstation application. (4 Way Stop may start after the winstation application and 
reside in the foreground – press anywhere behind 4 Way Stop to bring winstation to the foreground.) 

7. After Secure Suite 4 MICROS 9700 and 4 Way Stop are installed on the terminal, the following files should 
be present: 

 
Win32 

…Shift4\4Go\Bin 

• S4SecurePayment.dll 
• S4WayStop.exe 

...Shift4\4Go\etc 

• FourGoDCE.cfg 
• Strings.ini 

 
WS4, WS4LX, WS5, or WS5A 

…CF\Micros\Bin 
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• FourGoDCE.exe 
• S4WayStopCE.exe 

...CF\Micros\etc 

• FourGoDCE.cfg 
• Strings.ini 

8. Repeat Steps 1, 2, 3, 4, and 5 on each Non-SAR terminal with CAL as required. 

 

Installing Secure Suite 4 MICROS 9700 on Non-SAR Terminals without CAL 
If the terminal is a Win32 (Eclipse 2010, 2015, 5A POSReady 2009, or a Desktop PC based workstation) and does 
not have the MICROS CAL application installed, Secure Suite 4 MICROS 9700 and 4 Way Stop can still be installed.  

To install Secure Suite 4 MICROS 9700 and 4 Way Stop, perform the following steps on each Non-SAR terminal 
without CAL installed: 

1. Log on to the terminal without CAL as Administrator. 

2. Copy the S4WayStopSetup.exe file from the following directory on the server 
...ClientInstalls\CALInstall\Win32\Packages\Shift4 4Go and paste it on the terminal’s desktop. 

3. Copy the Shift4 folder from \MICROS\LES\POS\9700\ClientInstalls\CALInstall\Win32\Files and paste it 
in the terminal’s C:\ drive.  

4. Verify the following file placements: 

C:\Shift4\4Go\bin 

• No files (empty) 

C:\Shift4\4Go\etc  

• FourGoDCE.cfg 
• Strings.ini 

C:\Shift4\Param 

• CaDOTN.param 

5. On the terminal’s desktop, double-tap S4WayStopSetup.exe to run the 4 Way Stop installer. 

• After 4 Way Stop is installed on the terminal, the following files should be present: 
C:\Shift4\4Go\bin 

• S4SecurePayment.dll 
• S4WayStop.exe 

6. Repeat Steps 1, 2, 3, 4, and 5 on each Non-SAR terminal without CAL as required. 

7. Read “Rebooting Terminals without CAL” which contains important information about rebooting these 
terminals once Secure Suite 4 MICROS 9700 and 4 Way Stop have been installed. 
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Rebooting Terminals without CAL 

Anytime a terminal without CAL is rebooted once Secure Suite 4 MICROS 9700 and 4 Way Stop have been installed, 
the terminal’s user must tap the 4Go application window on the terminal to give the 4Go window focus.  

If the user fails to tap the 4Go application window after rebooting, the following error will occur the next time a 
card is swiped on the terminal: Entry error - Please retry - 4Go. To recover from this error message, perform the 
following steps on the terminal: 

1. On the 4Go window, tap the Cancel button. 

2. Tap the Clear button to clear the error message. 

3. On the Touchscreen, tap the CCard Auth button. 

4. Finish the card transaction as usual. 
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MICROS System Configuration 
Use the Enterprise Management Console (EMC) to configure the MICROS 9700 system for Secure Suite 4 MICROS 
9700 by modifying System Hardware, System Information, RVC Information, and Touchscreens. 

Accessing the EMC and the Configurator Within 
If the EMC was closed, to access the EMC and the Configurator within, perform the following steps: 

1. From the Start menu, select Programs > MICROS Applications > EMC. 

2. In the MICROS 9700 Server Selector window, select or type the name of the server and click Connect. 

 

 
 

3. In the Login to 9700 Server window, the merchant will perform the following: 

 

 
 

• In the User box, the merchant types their MICROS 9700 ID. 
• In the Password box, the merchant types their MICROS 9700 password. 
• Click Login. 

 



 Secure Suite 4 MICROS 9700 Version 3 
Technical Installation Guide 

© 2019 Shift4 Payments, LLC. All rights reserved. Version 1.7 
External Use NDA Page 46 of 130 

4. In the EMC window, under MODULES, select Configurator. 

 

 
 

 

Tip: Maximize the EMC window to ensure all settings, options, and menus 
are visible. 
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Navigating the EMC Window 
The buttons located at the top of the EMC window are useful when navigating the tabs. The following table 
describes each button: 

 

Button Action 

 
Connect to the server. 

 
Disconnect from the server. 

 
Save the configuration settings. 

 
Print the current configuration settings. 

 
Preview the screen as it will appear when printed. 

 
Cut a highlighted selection. 

 
Copy a highlighted selection for pasting later. 

 
Paste a previously cut or copied section. 

 
Undo a previous change. 

 
Toggle between Table view and Form view. 

 
Navigate to the previous tab. 

 
Navigate to the next tab. 

 
Access the first record. 
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Button Action 

 
Access the previous record. 

 
Access the next record. 

 
Access the last record. 

 
Create a new record for configuration. 

 
Delete the current record. 

 
Go directly to a particular record. 

 
Find a word or phrase. 

 
Go to the previous Internet link. 

 
View language translation options. 

 
Access the Revenue Center Selector and activate a revenue center for configuration. 

 
Toggle to display or hide the system panel. 

 

System Hardware Settings 
The Configurator provides access to the System Hardware menu where changes will be made to Interfaces and the 
Device Table settings to support Secure Suite 4 MICROS 9700’s CaDOTN interface and driver.  
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Configuring Interfaces 
To add and configure Secure Suite 4 MICROS 9700’s CaDOTN interface, perform the following steps: 

1. In the EMC window, on the Configurator tab, locate System Hardware and select Interfaces. 
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2. In the EMC window, on the Interfaces tab, click  to add a new interface. 

 

 
 

3. In the Insert Record window: 

 

 
 

• Select Next available position. 

• Click OK to add the record for the new interface. 
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• Record the number assigned to the new interface on your reference list, you will need it 
later. 

4. In the EMC window, on the Interfaces tab, verify the new interface record is selected and click  to 
switch to Form view. 

5. Configure the following settings: 

 

 
 

• In the PC Number list, select your primary PC. 
• In the System Name box, type CaDOTN (type CaDOTN exactly as shown without deviation 

from spelling or case). 

• In the Service Type list, select PMS/SIM. 
• In the Timeout box, type 90. 
• In the Type list, select TCP. 
• In the Ping Frequency box, verify that 0 appears and type if not. 
• In the TCP Host Name box, type the MICROS Server IP Address. 

• In the Port Number box, type 8797 which is the default port number. If you change the 
default, record the port number on your reference list, you will need it later. 

• In the ISL Script Name box, type CaDOTN. 

• Verify None is selected in the following lists:  
o Backup Interface 
o Offline Posting Link 
o SIMDB Link 

• Select Use 19 Digit Reference Entry for PMS Inquiries. 



 Secure Suite 4 MICROS 9700 Version 3 
Technical Installation Guide 

© 2019 Shift4 Payments, LLC. All rights reserved. Version 1.7 
External Use NDA Page 52 of 130 

• Select Allow Inquiry without Sign-In. 
• Select ON = Use 9 digits for Terminal IDs; OFF = Use 2 di. if terminal IDs have three digits or 

more; if terminal IDs have two digits or less, leave this option cleared. 

6. Click  to save the settings and close the Interfaces tab. 

 

Verifying a Registry Editor Setting 

After adding the new interface, CaDOTN, verify a Registry Editor setting by performing the following steps: 

1. From the Start menu, select Run. 

2. Type regedit and click Ok. 

3. In the Registry Editor window, navigate to HKEY_LOCAL_MACHINE\SOFTWARE\MICROS\9700\diskless. 

4. Locate NIC_IP and verify the MICROS Server IP Address appears in the Data column. 

 

 
 

5. If the IP Address is incorrect, double-click NIC_IP to open the Edit String window. 

6. On the Edit String window, in the Value data box, type the MICROS Server IP Address and click Ok. 

7. Close the Registry Editor window. 
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Configuring Device Table 
To reference Secure Suite 4 MICROS 9700’s CaDOTN driver, perform the following steps: 

1. In the EMC window, on the Configurator tab, locate System Hardware and select Device Table. 

 

 
 

2. In the EMC window, on the Device Table tab, select your primary PC from the system tree. 
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3. Click the General tab and configure the following: 

 

 
 

• In the CA Driver Filename box, type CaDOTN (type CaDOTN exactly as shown without 
deviation from spelling or case). 

4. Click  to save the setting. 

5. Repeat Steps 2, 3, and 4 if a secondary PC is being utilized. 
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Configuring Printers 

To configure printing for each workstation, perform the following steps: 

1. In the EMC window, on the Device Table tab, expand SCC in the system tree. 

2. Under SCC, select a workstation from the system tree. 

3. Click the Printers tab and verify the Credit Card Voucher box has a printer selected. If not, perform the 
following steps: 

 

 
 

• Next to the Credit Card Voucher box, click Select. 
• In the Select? window, select the applicable printer (usually the same as Guest Check). 

• Click Ok. 

• Click  to save the setting.  

4. Repeat Steps 2 and 3 for each workstation. 

5. Close the Device Table tab. 
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System Information Settings 
The Configurator provides access to the System Information menu where changes will be made to the Tender 
Media settings. 

Configuring Tender Media 
To configure tender media settings for each credit card tender, perform the following steps: 

1. In the EMC window, on the Configurator tab, locate System Information and select Tender Media. 

 

 
 



 Secure Suite 4 MICROS 9700 Version 3 
Technical Installation Guide 

© 2019 Shift4 Payments, LLC. All rights reserved. Version 1.7 
External Use NDA Page 57 of 130 

2. On the Tender Media tab, record the cash tender number and each credit card tender number on your 
reference list, you will need them later. Ensure the numbers you record have a Type of Payment – not 
Preamble (this information is located in the Type column). 

 

 
 

3. Select a credit card tender and click  to switch to Form view.  

4. Continue to “Configuring the Credit Card Tender with the Options Tab.” 
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Configuring the Credit Card Tender with the Options Tab 

Changes will be made to the credit card tender’s settings by using the Options tab which provides access to the 
Credit Card Options, POS Behavior, and Charge Tip Options categories. 

Configuring the Credit Card Options Category 

1. Click the Options tab. 

2. Under Select Category, select Credit Card Options from the list. 

3. Under Credit Card Options, configure the following: 

 

 
 

• Type 0.00 in the following boxes: 
o Estimated Tip Percentage 
o Base Limit 
o Second Limit 
o Second Limit Percentage 

• In the Initial Authorization Amount box, type the amount in use (if the MICROS Initial 
Authorizations feature is not in use, type 0.00 in this box). 

• (Optional) In the Quick Service Limit box, type the threshold dollar amount below which the 
system will obtain authorization but will not require a signature. 

• Select the following options: 
o Check Credit Card Expiration Date 
o Require Credit Auth Before Service Total 
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• Clear Credit Card Validity Test to avoid unnecessary, duplicate verification of the credit card 
which slows processing. 

4. Click  to save the settings. 

 

Configuring the POS Behavior Category 

1. Under Select Category, select POS Behavior from the list. 

2. Under POS Behavior, under Amount Options, configure the following: 

 

 
 

• If retail functions are being used, select Assume Paid in Full and clear Amount Required. 
Selecting this option will record the exact amount due as the entry. If this option is not 
selected, the system will record 0.00 as the entry. 

3. Click  to save the settings. 
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Configuring the Charge Tip Options Category 

If Charged Tip is in use, perform the following steps: 

1. Under Select Category, select Charge Tip Options from the list. 

2. Under Charge Tip Options, configure the following: 

 

 
 

• In the Service Charge list, select the service charge number for charged tip. 
• Record the Charged Tip Number on your reference list, you will need it later. 
• Select the following options: 

o Charged Tip Required 
o Post Amount to Gross Receipts on Tip Reports 
o Post Amount to Charged Receipts on Tip Reports 

• (Optional) Clear ON = Charged Tip Must Be Less Then Pmt; OFF = Any Amount to allow a tip 
of any amount. If this option is selected, the tip must be less than the payment amount. 

3. Click  to save the settings. 

4. Continue to “Configuring the Credit Card Tender with the Menu Levels Tab.” 
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Configuring the Credit Card Tender with the Menu Levels Tab 

To configure the Menu Levels for the credit card tender, perform the following steps: 

1. Click the Menu Levels tab and configure the following: 

 

 
 

• Under Active On Main Levels, select each Main Level in the list. 
• Under Active On Sub Levels, select each Sub Level in the list. 
• In the Main Level Popup list, select Stay Down. 
• In the Sub Level Popup list, select Stay Down. 

2. Click  to save the settings. 

3. Continue to “Configuring the Credit Card Tender with the Output Tab.” 
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Configuring the Credit Card Tender with the Output Tab 

The Output tab controls the credit card tender’s ability to support printing credit card receipts. To configure, 
perform the following steps: 

1. Click the Output tab and configure the following: 

 

 
 

• Select Print on Customer Receipt. 
• Select Print on Journal. 
• Select Print on Guest Check. 

2. Click  to save the settings. 

 

 

Requirement: Repeat all sections in “System Information Settings” to 
configure each credit card tender as required. 

Click  to return to Table view and select the next credit card tender 
to configure. 

After all credit card tenders are configured, close the Tender Media tab. 
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RVC Information Settings 
The Configurator provides access to the RVC Information menu where changes will be made to Revenue Center 
(RVC) Parameter settings regarding default seat number, interface assignment, and secondary floor limits. 

 

Configuring RVC Parameters 
To configure RVC parameters for each revenue center, perform the following steps: 

1. In the EMC window, on the Configurator tab, locate RVC Information and select Parameters. 
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2. On the RVC Parameters tab, record the name and number assigned to each revenue center on your 
reference list, you will need them later. 

 

 
 

3. Select a revenue center and click  to switch to Form view.  

4. Continue to “Configuring the Revenue Center with the Options Tab.” 
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Configuring the Revenue Center with the Options Tab 

To deactivate the default seat number, perform the following steps: 

1. Click the Options tab. 

2. Under General, locate and clear Default Seat Number to 1 at Beginning of a Trans. 

 

 
 

3. Click  to save the settings. 

4. Continue to “Configuring the Revenue Center with the Interfaces Tab.” 
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Configuring the Revenue Center with the Interfaces Tab 

To configure the revenue center to use Secure Suite 4 MICROS 9700’s CaDOTN interface, perform the following 
steps:  

1. Click the Interfaces tab. 

2. Under Interfaces, in list 6 (if available), select CaDOTN. (The open lists are set to None. Shift4 Payments 
recommends using the same assigned interface slot for all revenue centers to ensure efficient referencing 
when configuring settings. The suggested list is 6.) 

 

 
 

3. Click  to save the settings. 

4. Continue to “Configuring the Revenue Center with the CA/EDC Tab.” 
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Configuring the Revenue Center with the CA/EDC Tab 

To establish secondary floor limits and printing operations to ensure the revenue center in the MICROS 9700 
system recognizes numerical and percentage floor limits as well as credit card printing information, perform the 
following steps: 

1. Click the CA/EDC tab. 

2. Under Options, configure the following: 

 

 
 

• Select Use Percent Secondary Floor Limits. 
• Select Use Amount Secondary Floor Limits. 
• Select Print Two Lines of Discretionary Driver Data. 

• If Charged Tip is in use, clear Do Not Estimate Tips of Credit Card Authorizations. 
• If you have a thermal printer, select Print Two Credit Card Vouchers. 
• In the Credit Driver Instance list, select None. 

3. Click  to save the settings. 

 

 

Requirement: Repeat all sections in “RVC Information Settings” to 

configure each revenue center as required.  Click  to return to Table 
view and select the next revenue center to configure. After all revenue 
centers are configured, close the RVC Parameters tab. 
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Touchscreen Settings 
The MICROS Touchscreen settings must be configured to process transactions using Secure Suite 4 MICROS 9700’s 
CaDOTN Inquiry Numbers. The table below lists the buttons on the MICROS Touchscreen that will need to be 
configured if present. 

 

Existing MICROS 
Function Name 

Existing MICROS 
Key Number 

New CaDOTN 
Inquiry Number Notes 

CCard Lookup 625 9 Used for retail credit card authorization and 
settlement. 

CCard Lookup/Ask 626 None – Delete or 
Reconfigure 

If CCard Lookup is in use, delete CCard 
Lookup/Ask and use CCard Lookup. 

 

If CCard Lookup is not in use, reconfigure 
CCard Lookup/Ask to use CaDOTN Inquiry 9. 

 

Instruct the clerk to enter the amount 
before pressing CCard Lookup/Ask. 

CCard Recall 627 None – Delete or 
Reconfigure 

Secure Suite 4 MICROS 9700 protects against 
recalling credit card data. 

CCard Recall/Ask 628 None – Delete or 
Reconfigure 

Secure Suite 4 MICROS 9700 protects against 
recalling credit card data. 

CCard Authorize 629 8 Used for food and beverage credit card 
authorization and settlement. 

Initl Authorize 631 14 Used for credit card authorization only. 

Manual Authorize 632 11 Used for manual and telephone credit card 
authorization only. 
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Existing MICROS 
Function Name 

Existing MICROS 
Key Number 

New CaDOTN 
Inquiry Number Notes 

CCard Auth/Prompt 633 None – Delete or 
Reconfigure 

If CCard Authorize is in use, delete CCard 
Auth/Prompt and use CCard Authorize. 

 

If CCard Authorize is not in use, reconfigure 
CCard Auth/Prompt to use CaDOTN Inquiry 

8. 

 

Instruct the clerk to enter the amount 
before pressing CCard Auth/Prompt. 

Initl Auth/Prompt 635 None – Delete or 
Reconfigure 

If Initl Authorize is in use, delete Initl 
Auth/Prompt and use Initl Authorize. 

 

If Initl Authorize is not in use, reconfigure 
Initl Auth/Prompt to use CaDOTN Inquiry 14. 

 

Instruct the clerk to enter the amount 
before pressing Initl Auth/Prompt. 

Manual Auth/Prompt 636 None – Delete or 
Reconfigure 

If Manual Authorize is in use, delete Manual 
Auth/Prompt and use Manual Authorize. 

 

If Manual Authorize is not in use, 
reconfigure Manual Auth/Prompt to use 

CaDOTN Inquiry 11. 

 

Instruct the clerk to enter the amount 
before pressing Manual Auth/Prompt. 

 

Configuring the Touchscreen 
To configure the Payment Touchscreen, perform the following steps: 

1. In the EMC window, on the Configurator tab, locate the Revenue Center Selector list (bottom-right-
corner) and select a revenue center. 

2. In the EMC window, on the Configurator tab, locate the Touchscreens, Keyboards, and KDS menu. Under 
Workstations, select Design. 
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3. On the Touchscreen Design tab, from the Names column, select the Payment Touchscreen. In most cases, 
your payment screen will be named PAYMENT, PAYMENT AUTH, or something similar. 

 

 
 

4. Click  to switch to Form view. 

5. Continue to “Configuring a Credit Button for its CaDOTN Inquiry Number.” 
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Configuring a Credit Button for its CaDOTN Inquiry Number 

1. On the Touchscreen Design tab, select a credit button with an Existing MICROS Function Name. The 
Existing MICROS Function Names are listed in the table under “Touchscreen Settings." 

o In this example, the button is CCard Auth and has an Existing MICROS Function 
Name of CCard Authorize.  

 

 
 

2. From the Key Type list, select Function. 

3. Click  next to the Key Number list to open the Key Function Select window. 
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4. In the Key Function Select window, configure the following:  

 

 
 

• On the left side of the window, select SIM. 

• On the right side, select the new, corresponding CaDOTN Inquiry Number: 
o Formatting example: X – SIM # – CaDOTN – Inq ? where X is a number generated by 

MICROS, # is the CaDOTN interface number previously created and ? is the CaDOTN 
Inquiry Number from the table under “Touchscreen Settings.” 

o In this example, it would be either 1027 – SIM 6 – CaDOTN - Inq 8 if the revenue 
center is Food and Beverage or 1028 – SIM 6 - CaDOTN - Inq 9 if the revenue center 
is Retail. 

• Click OK to close the window. 

5. Click  to save the settings. 

6. Repeat Steps 1, 2, 3, 4, and 5 for all credit buttons on the Payment Touchscreen with an Existing MICROS 
Function Name from the table under “Touchscreen Settings.” 

7. Repeat all sections in “Configuring the Touchscreen” to configure additional Touchscreens (if credit 
buttons exist on other screens, other than Payment) for the selected revenue center. This is required to 
ensure the system is completely functional. After all touchscreens are configured for the selected revenue 
center, proceed to Step 8. 

8. Repeat all sections in “Touchscreen Settings” if additional revenue centers need to be configured. 



 Secure Suite 4 MICROS 9700 Version 3 
Technical Installation Guide 

© 2019 Shift4 Payments, LLC. All rights reserved. Version 1.7 
External Use NDA Page 73 of 130 

Parameter File Settings 
The CaDOTN.param file must be updated to reflect your newly configured settings in the MICROS 9700 system to 
support Secure Suite 4 MICROS 9700. To update the parameter file, perform the following steps: 

1. Navigate to …\MICROS\LES\POS\9700\Etc and open CaDOTN.param in WordPad or Notepad. 

2. Continue to “Updating the Printing Parameters.” 

Updating the Printing Parameters 
1. Locate the Printing section: 

 

 
 

 

Tip: Search the document for key words to locate the sections quickly. 

 

2. Update the Printing Parameters according to your newly configured settings in the MICROS 9700 system 
by typing the applicable Required Setting from the table below: 

 

Printing Parameter Required Setting Notes 

var ManagerDraftPrint 
If Charged Tip is in use: "Y" 

If not in use: "E" 

Y = Enhanced printing enabled 

N = Enhanced printing disabled 

E = Enhanced printing enabled to print 
errors only 

 
var CustomerDraftPrint 

If Charged Tip is in use: "Y" 

If not in use: "N" 

 

3. Save the CaDOTN.param file but do not close it. 

4. Continue to “Updating the Tender Keys Parameters.” 
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Updating the Tender Keys Parameters 
1. Locate the Tender Keys section: 

 

 
 

2. Update the Tender Keys Parameters according to your newly configured settings in the MICROS 9700 
system by typing the applicable Required Setting from the table below: 

 

Tender Keys 
Parameter Tender Media Payment Type Required Setting 

var DB_TENDER Debit 

If in use: (7,#) where # is the Tender Media 
Number recorded on your reference list. 

 

If not in use: (7,999). 

var VS_TENDER Visa 

var MC_TENDER MasterCard 

var NS_TENDER Novus/Discover 

var AX_TENDER American Express 

var JC_TENDER Japanese Credit Bureau 

var DC_TENDER Diners Club 

var CASH_TENDER Cash 
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Tender Keys 
Parameter Tender Media Payment Type Required Setting 

var TIP_SVC_OBJ Charged Tip 

If in use: (5,#) where # is the Charged Tip 
Service Charge Number recorded on your 

reference list. 

 

If not in use: (5,999) 

var CHG_TIP_ACTIVE N/A 
If in use: "Y" 

If not in use: "N" 

 

3. Save the CaDOTN.param file but do not close it. 

4. Continue to “Updating the Revenue Center Parameters.” 
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Updating the Revenue Center Parameters 
1. Locate the Revenue Center section:  

 

 
 

2. Update the Revenue Center Parameters according to your newly configured settings in the MICROS 9700 
system by typing the applicable Required Setting from the table below: 

 

Revenue Center 
Parameter Required Setting 

var storenames [#]: a66 
# equals the highest MICROS RVC 

Number recorded on your reference 
list. 

storenames [n] = "x" 

n equals the MICROS RVC Number 
recorded on your reference list. 

 

x is the MICROS RVC Name recorded 
on your reference list that corresponds 
to n and is typed within double quotes. 

 

3. Save the CaDOTN.param file but do not close it. 

4. Continue to “Updating the Log and Operation Parameters” section. 
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Updating the Log and Operation Parameters 
1. Locate the Log and Operation section: 
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2. Update the Log and Operation Parameters according to your newly configured settings in the MICROS 
9700 system by typing the applicable Required Setting from the table below: 

 

Log and Operation 
Parameter Required Setting Notes 

*log_retain 6 The number of days to retain the log file. 

*log_rolltime “xx:yy:zz” 

Where xx:yy:zz is the time (xx is the hour in a 24- 
hour format, yy is the minutes, and zz is the 

seconds) the system will roll to a new log file, where 
xx, yy, and zz are separated by a colon and typed 

within double quotes. 

 

This time should be ten seconds before the MICROS 
system’s configured start of day time, which the 

merchant can provide. 

 

The default is ten seconds before midnight: 
“23:59:50” 

*validate_cards 0 The setting disables duplicate card validation. 

*max_uws 200 or greater The maximum number of user 
workstations/terminals. 

*ca_retry_max 0 A setting other than zero delays messages from 
appearing on the screen. 

*edc_high_capacity 
0 = false 

1 = true 

Indicates when settlement is being run as a high 
capacity batch. 

 

The default is false. 

*edc_highc_links 3 

The maximum number of simultaneous connections 
to use if high capacity batch is enabled. 

 

The default value is 3, the minimum value is 1, and 
the maximum value is 10. 
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Log and Operation 
Parameter Required Setting Notes 

*edc_highc_quelen 12 

The maximum number of queue depth for 
connections if high capacity batch is enabled. 

 

The default value is 12, the minimum value is 3, and 
the maximum value is 24. 

 

3. Save the CaDOTN.param file but do not close it. 

4. Continue to “Updating the Link Settings Parameters” section. 
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Updating the Link Settings Parameters 
1. Locate the Link Settings section: 

 

 
 

2. In the second column, be aware of the following: 

• 0 = Primary Link Parameters 
• 1 = Secondary Link Parameters 

3. Update the Link Settings (Primary and Secondary) Parameters according to your newly configured settings 
in the MICROS 9700 system by typing the applicable Required Setting from the table below: 

 

Link Settings 
Parameter Required Setting Notes 

*ca_sys_name 
The name of the link address 
typed within double quotes. 

 

The Primary Link default is “MADWAND1” 

The Secondary Link default is “MADWAND2” 

*ca_sys_addr 
The MicrosTCP Interface IP 

Address typed within double 
quotes. 

The MicrosTCP Interface IP Address recorded on your 
reference list. 

*ca_sys_port The MicrosTCP Port Number. The MicrosTCP Port Number recorded on your 
reference list. The default is 17478.  

*ca_sys_tout 
65 

 

The amount of time the system waits, in seconds, 
before indicating an attempted transaction has failed. 

The default is 65. 
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Link Settings 
Parameter Required Setting Notes 

*ca_sys_use9 
0 – Disabled 

1 – Enabled 

If the terminal IDs are two digits or less, type 0. 

If the terminal IDs are three digits or more, type 1. 

*ca_sys_usetcp 1 
This setting specifies a TCP/IP connection for 

communications between Secure Suite 4 MICROS 9700, 
the UTG, and the MICROS 9700 system. 

 

4. Update the Backup Preference Parameters (how the Primary and Secondary link will be used by the 
system) according to your newly configured settings in the MICROS 9700 system. There are three setting 
configurations to choose from, type the applicable Required Setting from the table below: 

 

Backup Preference Parameter 
Configuration Choices 

Required 
Setting Notes 

*dual_ca_sys 

*backup_ca_sys 

1 

0 
The system uses both the Primary and Secondary Links 

when sending transmissions. 

*dual_ca_sys 

*backup_ca_sys 

1 

1 
The system uses the Secondary Link only when the 

Primary Link has failed. 

*dual_ca_sys 

*backup_ca_sys 

0 

0 
The system does not use the Secondary Link. 

 

5. Update the Interface Parameter according to your newly configured settings in the MICROS 9700 system 
by typing the applicable Required Setting from the table below: 

 

Interface Parameter  Required Setting Notes 

*pms_entry The CaDOTN Interface Number 
recorded on your reference list. The default is 6. 

 

6. Save the CaDOTN.param file but do not close it. 
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7. Continue to “Updating the RVC Assignments Parameters” section. 

 

Updating the RVC Assignments Parameters 
1. Locate the Revenue Center Assignments section: 

 

 
 

2. In the second column, be aware of the following: 

• Each revenue center has an identifying number in the second column. All parameters with 
the same identifying number in the second column belong to that revenue center.  

3. Unless instructed otherwise, only edit parameters located in the third column. 

4. Update the RVC Assignments Parameters for each revenue center according to your newly configured 
settings in the MICROS 9700 system by typing the applicable Required Setting in the third column from 
the table below: 

 

RVC Assignments 
Parameter Required Setting 

*rvc_no Type the RVC Number recorded on your reference list. 

*rvc_merch Type the Shift4 Payments Merchant ID recorded on your reference list that 
corresponds to the RVC Number. 



 Secure Suite 4 MICROS 9700 Version 3 
Technical Installation Guide 

© 2019 Shift4 Payments, LLC. All rights reserved. Version 1.7 
External Use NDA Page 83 of 130 

RVC Assignments 
Parameter Required Setting 

*rvc_type 

Type the Merchant Type recorded on your reference list that corresponds to 
the RVC Number: 

R = Retail 

F = Food & Beverage 

K = Kiosk 

*rvc_name Type the RVC Name recorded on your reference list that corresponds to the 
RVC Number within double quotes. 

*rvc_api_serial If the parameter is not in use, set to "" 

 

5. If needed, to add additional revenue centers to the CaDOTN.param file: 

• Copy the last block of RVC Assignments Parameters content (all three columns). 
• Paste the copied selection below the last block of RVC Assignments Parameters. 
• In the pasted content, increment the identifying number in the second column by 1 for all of 

the RVC Assignments Parameters that will now correspond to this new, additional revenue 
center. 

• Repeat Step 4 to update the added revenue center. 
• Review the section “Updating the Revenue Center Parameters” to ensure the added revenue 

center is included in this area as well. 

6. Save and Close the CaDOTN.param file. 

 

Rebuilding the CaDOTN.dat File 
If the MICROS 9700 system is being upgraded from Shift4 Payments’ Enhanced driver, after editing the 
CaDOTN.param file, you must delete the CaDOTN.dat file. This ensures the MICROS 9700 system rebuilds the 
CaDOTN.dat file using the updated CaDOTN.param file once it is restarted. To delete the CaDOTN.dat file, perform 
the following steps: 

1. Navigate to ...MICROS\LES\POS\9700\etc. 

2. Locate CaDOTN.dat, right-click and select Delete. 
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Replacing the CaDOTN.param File 
After editing and saving the changes made to the CaDOTN.param file, replace the old CaDOTN.param file in the 
following directories on the server with the new version: 

\MICROS\LES\POS\9700\ClientInstalls\CALInstall\Win32\Files\Shift4\Param 

\MICROS\LES\POS\9700\ClientInstalls\CALInstall\WS4\Files\CF\PosClient\Sim 

\MICROS\LES\POS\9700\ClientInstalls\CALInstall\WS4LX\Files\CF\PosClient\Sim 

\MICROS\LES\POS\9700\ClientInstalls\CALInstall\WS5\Files\CF\PosClient\Sim 

\MICROS\LES\POS\9700\ClientInstalls\CALInstall\WS5A\Files\CF\PosClient\Sim 

 

Shared Secret Passphrase Settings 
The UTG has been configured to communicate with the CaDOTN driver using a shared secret passphrase. To 
configure the CaDOTN driver for the shared secret passphrase, perform the following steps: 

1. From the Start menu, select Programs > Shift4 Corporation > Secure Suite 4 MICROS 9700 > Secure Suite 
4 MICROS 9700 Password Utility. 

2. In the Shift4 Enhanced Driver Password Control window, configure the following:  

 

 
 

• Under Primary UTG TCP/IP Connection: 
o In the Passphrase box, type the shared secret passphrase configured in the UTG. 

(Remember, it is case sensitive.) 
o In the Verify Passphrase box, re-type the shared secret passphrase configured in 

the UTG. 
• Under Secondary UTG TCP/IP Connection: 

o In the Passphrase box, type the shared secret passphrase configured in the UTG. 
(Remember, it is case sensitive.) 

o In the Verify Passphrase box, re-type the shared secret passphrase configured in 
the UTG. 

3. (Optional) Before saving the changes, the Revert button can be used to restore the previous settings. 

4. Click Save. 
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5. When the MICROS 9700 system is restarted, the shared secret passphrase will be in effect. 

 

 

Requirement: If you are not doing “Gift Card Configuration,” which is an 
advanced and optional feature, proceed to the “Post-Installation 
Process.” 

Gift Card Configuration 
Secure Suite 4 MICROS 9700 enables gift card purchases, activations and deactivations, recharges, redemptions, 
and cashouts using the MICROS 9700 system. 

It is important to remember the following limitation when running as a SAR terminal on MICROS 9700 Version 3.2 
or 3.5: gift card functions are not supported. 

 

 

Requirement: Complete all tasks in “Installing and Configuring Secure 
Suite 4 MICROS 9700” and “MICROS System Configuration” prior to doing 
Gift Card Configuration. 

 

System Information Settings 
The Configurator provides access to the System Information menu where changes will be made to the Service 
Charges and Tender Media settings to support gift cards. 

 

 

Requirement: When adding service charges and tender media, MICROS 
customers must contact their Accounting department to verify placement 
of the service charges and tender media in the correct tracking group for 
reporting.  

Until the service charges and tender media are added to tracking groups, 
they will not show up in any reports. 

For assistance, customers must contact MICROS for support. 
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Configuring Service Charges 
There are three service charges needed to support gift cards: 

• (Required) GC SALE – Allows merchants to sell gift cards with any value. GC SALE does not apply to gift 
card redemptions; its use is for selling gift cards. 

• (Required) GC RECHARGE – Allows merchants to add additional value to gift cards. 
• (Optional) GC CASHOUT – Allows customers to redeem the remaining value of a gift card for cash if the 

merchant chooses to configure. 

 

To configure the new service charges to support gift cards, perform the following steps: 

1. In the EMC window, on the Configurator tab, locate System Information and select Service Charges. 

 

 
 

2. On the Service Charges tab, click  to switch to Table view. 
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3. On the Service Charges tab, click  to add a new service charge number. 

 

 
 

4. Record the number assigned to the new service charge on your reference list, you will need it later. 

5. On the Service Charges tab, verify the new service charge is selected and click  to switch to Form 
view. 

6. Continue to “Configuring the Service Charge with the General Tab.” 
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Configuring the Service Charge with the General Tab 

1. Click the General tab and configure the following: 

 

 
 

• In the Name box, type GC SALE.  

 

 

Requirement: Type GC SALE, GC RECHARGE, and GC CASHOUT exactly as 
shown without deviation from spelling or case, and with only one space 
between the words. 

 

• In the Amount box, type 0, which is the default. If this is an Amount Service Charge, this field 
determines the dollar amount of the service charge. If this is a Preset Percentage or an Open 
Amount Service Charge, this field determines the maximum amount of the service charge. 
The number of fixed decimal places is determined by the setting for the base currency in the 
Currency file. 

• In the Tax Class list, select None, which is the default. If needed, a tax class can be selected 
to apply to this service charge. 

• In the Tips Paid Tender/Media list, select None. 
• In the Privilege Group list, select 0, which is the default. If needed, a privilege group number 

can be selected to restrict use of this service charge to employees who are linked to the 
privilege group number. 

• In the Percent To Tips Paid box, type 0, which is the default. If needed, a percentage of the 
charged tip can be configured here to post to the Tips Paid total. 
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2. Under Options, configure the following: 

• Select ON = Open; OFF = Present. 
• Select ON = Amount; OFF = Percentage. 
• Select Reference Entry Required. 

3. Click  to save the settings. 

4. Continue to “Configuring the Service Charge with the Itemizers Tab.” 

 

Configuring the Service Charge with the Itemizers Tab 

1. Click the Itemizers tab and configure the following: 

 

 
 

• Select each Compute on Service Charge Itemizer in the list. 

2. Click  to save the settings. 

3. Continue to “Configuring the Service Charge with the Menu Levels Tab.” 
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Configuring the Service Charge with the Menu Levels Tab 

1. Click the Menu Levels tab and configure the following: 

 

 
 

• Under Active On Main Levels, select each Main Level in the list. 
• Under Active On Sub Levels, select each Sub Level in the list. 
• In the Main Level Popup list, select Stay Down. 
• In the Sub Level Popup list, select Stay Down. 

2. Click  to save the settings. 

3. Continue to “Configuring the Service Charge with the NLU/SLU Tab.” 
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Configuring the Service Charge with the NLU/SLU Tab 

1. Click the NLU/SLU tab and configure the following: 

 

 
 

• In the NLU box, type 0. 
• In the SLU list, select None. 
• In the MMH SLU list, select None. 

• In the Icon list, select None. 

2. Click  to save the settings. 

3. Continue to “Configuring the Service Charge with the Output Tab.” 
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Configuring the Service Charge with the Output Tab 

1. Click the Output tab and configure the following: 

 

 
 

• Select Print on Customer Receipt. 
• Select Print on Journal. 
• Select Print on Guest Check. 

2. Click  to save the settings. 

 

 

Requirement: Repeat all sections in “Configuring Service Charges” to 
configure each gift card service charge (GC SALE, GC RECHARGE, and GC 
CASHOUT) as required. After each gift card service charge is configured 
(GC CASHOUT is optional), close the Service Charges tab. 
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Configuring Tender Media 
To add and configure tender media settings for the new gift card tender, perform the following steps: 

1. In the EMC window, on the Configurator tab, locate System Information and select Tender Media. 
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2. On the Tender Media tab, click  to add a new tender. 

 

 
 

3. In the Insert Record window: 

 

 
 

• Select Record number or range and type an available number: 
o The number typed in must be less than 60 and have an available number preceding 

it. For example, if the last number in use on the Tender Media tab is 11, type 13. 
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This will ensure the number 12 is available for configuring an alternate gift card 
preamble if zero and another number are being used as gift card preambles. 

• Click OK to add the record for the new tender media. 

• Record the number assigned to the new tender media on your reference list, you will need it 
later. 

4. On the Tender Media tab, verify the new tender media is selected and click  to switch to Form view. 

5. Continue to “Configuring the Tender Media with the General Tab.” 
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Configuring the Tender Media with the General Tab 

1. Click the General tab and configure the following: 

 

 
 

• In the Name box, type Gift Card. 
• In the Privilege Group list, select 0, which is the default. If needed, a privilege group number 

can be selected to restrict use of this tender media to employees who are linked to the 
privilege group number. 

• In the Key Type list, select 1-Payment. 
• In the NLU box, type 0. 
• In the SLU list, select 0-None. 
• In the MMH SLU list, select 0-None. 
• In the Icon list, select 0-None. 

2. Click  to save the settings. 

3. Continue to “Configuring the Tender Media with the Options Tab.” 
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Configuring the Tender Media with the Options Tab 

Changes will be made to the gift card tender media’s settings by using the Options tab which provides access to 
the Credit Card Options, Interface Options, POS Behavior, and Charge Tip Options categories. 

Configuring the Credit Card Options Category 

1. Click the Options tab. 

2. Under Select Category, select Credit Card Options from the list. 

3. Under Credit Card Options, configure the following: 

 

 

 
 

• In the Preamble box, configure the following: 
o If zero is the gift card preamble, type 0*. 
o If zero is not the gift card preamble, type n* where n represents the gift card 

preamble. Record the preamble on your reference list as the Alt. Gift Card Preamble 
Number. 

o If zero and another number are being used as gift card preambles, type 0*. The 
other number will be added in the “Configuring an Alternate Gift Card Preamble” 
section that follows. 
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• Type 0.00 in the following boxes: 
o Estimated Tip Percentage 
o Base Limit 
o Second Limit 
o Second Limit Percentage 
o Initial Authorization Amount 
o Quick Service Limit 

• Select the following options: 
o Check Credit Card Expiration Date 
o Require Credit Auth Before Service Total 
o No Credit Card Length Check 

• Clear Credit Card Validity Test. 

4. Click  to save the settings. 

 

Configuring the Interface Options Category 

1. Under Select Category, select Interface Options from the list  

2. Under Interface Options, configure the following: 

 

 
 

• Clear Use ISL TMED Procedure Instead of PMS Interface to use the PMS interface. 

• Select ON = PMS and Credit Cards Use 19 Digit Acct Number; OFF = 16 Digits. 

3. Click  to save the settings. 
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Configuring the POS Behaviors Category 

1. Under Select Category, select POS Behavior from the list. 

2. Under POS Behavior, configure the following: 

 

 

 
 

• Under Amount Options, select Assume Paid in Full. 
• Under General Options, select Reference Entry Required. 

3. Click  to save the settings. 
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Configuring the Charge Tip Options Category 

If Charged Tip is in use, perform the following steps: 

1. Under Select Category, select Charge Tip Options from the list. 

2. Under Charge Tip Options, configure the following: 

 

 
 

• In the Service Charge list, select the Charge Tip Service Charge Number recorded on your 
reference list.  

• Select the following options: 
o Post Amount to Gross Receipts on Tip Reports 
o Post Amount to Charged Receipts on Tip Reports 

• (Optional) Clear ON = Charged Tip Must Be Less Then Pmt; OFF = Any Amount to allow a tip 
of any amount. If this option is selected, the tip must be less than the payment amount. 

3. Click  to save the settings. 
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Configuring the Miscellaneous Options Category 

If Charged Tip is in use, perform the following steps: 

1. Under Select Category, select Miscellaneous Options from the list. 

2. Under Signature Capture Options, configure the following: 

 

 
 

• In the Default Tip % box, type 0. 

3. Continue to “Configuring the Tender Media with the Menu Levels Tab.” 
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Configuring the Tender Media with the Menu Levels Tab 

To configure the Menu Levels for the gift card tender, perform the following steps: 

1. Click the Menu Levels tab and configure the following: 

 

 
 

• Under Active On Main Levels, select each Main Level in the list. 
• Under Active On Sub Levels, select each Sub Level in the list. 

• In the Main Level Popup list, select Stay Down. 
• In the Sub Level Popup list, select Stay Down. 

2. Click  to save the settings. 

3. Continue to “Configuring the Tender Media with the Output Tab.” 
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Configuring the Tender Media with the Output Tab 

The Output tab controls the gift card tender’s ability to support printing receipts. To configure, perform the 
following steps: 

1. Click the Output tab and configure the following: 

 

 
 

• Select Print on Customer Receipt. 
• Select Print on Journal. 
• Select Print on Guest Check. 

2. Click  to save the settings. 

3. If applicable, continue to “Configuring an Alternate Gift Card Preamble.” If not, close the Tender Media 
tab. 
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Configuring an Alternate Gift Card Preamble 

To add the preamble that is in addition to zero as the alternate gift card preamble, perform the following steps: 

1. Click  to switch to Table view. 

 

 
 

2. On the Tender Media tab, click  to add a new tender. 
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3. In the Insert Record window: 

 

 
 

• Select Record number or range and type the number preceding your newly created gift card 
tender number. 

o Continuing from our previous example, 12 would be typed in. 
• Click OK to add the record for the new tender media. 



 Secure Suite 4 MICROS 9700 Version 3 
Technical Installation Guide 

© 2019 Shift4 Payments, LLC. All rights reserved. Version 1.7 
External Use NDA Page 106 of 130 

4. On the Tender Media tab, configure the following: 

 

 
 

• Click the Name box next to the new tender media number and type Gift Card Preamble. 
• In the Type list, select 5 – Preamble.  
• Click the Preamble box and type n*, where n is a number other than zero and represents the 

alternate gift card preamble. Record the preamble on your reference list as the Alt. Gift Card 
Preamble Number – you will need it later. 

 

 

Requirement: For an alternate preamble to function, it must precede its 
tender media on the Tender Media tab. 

As in this example, 12 is the Alternate Gift Card Preamble and 13 is the 
Gift Card Tender Media. 

 

5. Click  to save the settings and close the Tender Media tab.  
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Personnel Settings 
The Employee Class numbers that require gift card activation and deactivation privileges must be recorded on your 
reference list, you will need them later. To find the numbers in the MICROS 9700 system, perform the following 
steps: 

1. In the EMC window, on the Configurator tab, locate Personnel and select Employees. 

 

 
 

2. On the Employees tab, select Maintenance. 
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3. On the Employee Maintenance tab, on the left side of the window, select the employee class that 
requires gift card activation and deactivation privileges. 

4. On the General tab, locate the Number box and record the number on your reference list. 

 

 
 

5. Repeat Steps 3 and 4 for each employee class that requires gift card activation and deactivation privileges. 

6. Close the Employee Maintenance tab. 
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Touchscreen Settings 
The MICROS Touchscreen settings must be configured to process transactions using Secure Suite 4 MICROS 9700’s 
CaDOTN Inquiry Numbers that support gift cards. 

 

The table below lists the buttons that will need to be added and configured on the MICROS Touchscreen according 
to your newly configured settings in the MICROS 9700 system. 

 

New 
Button 
Name 

New CaDOTN 
Inquiry 

Number 
Notes 

GC Inquire 

 
2 If added and configured on the Touchscreen, this button will report the 

balance of the gift card. 

GC Activate 

 
3 

If added and configured on the Touchscreen, this button will facilitate the 
reuse of a gift card with a zero balance by allowing managers or supervisors 

to activate a deactivated gift card. This does not add funds. 

GC Sale  

 
5 If added and configured on the Touchscreen, this button will activate a new 

gift card and add an initial balance to the gift card. 

GC Deactivate 

 
6 If added and configured on the Touchscreen, this button will allow managers 

or supervisors to deactivate a gift card.  

GC Cashout 

 
7 If added and configured on the Touchscreen, this button will allow the 

customer to redeem a gift card for cash. 

GC Retail 

 
10 

If added and configured on the Touchscreen, this button will report the 
balance of the gift card before processing the transaction to ensure sufficient 

funds – handles split tender in a retail environment if needed. 

GC Recharge 12 If added and configured on the Touchscreen, this button will add money to a 
previously activated gift card. 
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Configuring the Touchscreen 
To configure the Payment Touchscreen, perform the following steps: 

 

1. In the EMC window, on the Configurator tab, locate the Revenue Center Selector list (bottom-right-
corner) and select a revenue center. 

2. In the EMC window, on the Configurator tab, locate the Touchscreens, Keyboards, and KDS menu. Under 
Workstations, select Design. 

 

 
 

3. On the Touchscreen Design tab, from the Names column, select the Payment Touchscreen. In most cases, 
your payment authorization screen will be named PAYMENT, PAYMENT AUTH, or something similar.  
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4. Click   to switch to Form view. 

5. Continue to “Configuring a Gift Card Button for its CaDOTN Inquiry Number.” 

Configuring a Gift Card Button for its CaDOTN Inquiry Number 

1. On the Touchscreen Designer tab, click one of the New Button icons ( ), drag the new 
button to an open space on the screen, and configure the new button: 

 

 
  

2. In the Legend box, type the name of the new button being configured. 

• In this example, GC Inquire. 

3. In the Key Type list, select Function. 

4. Click  next to the Key Number list to open the Key Function Select window.  
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5. In the Key Function Select window, configure the following:   

 

 
 

• On the left side of the window, select SIM. 
• On the right side, select the new, corresponding CaDOTN Inquiry Number. 

o Formatting example: X – SIM # – CaDOTN – Inq ? where X is a number generated by 
MICROS, # is the CaDOTN interface number previously created and ? is the CaDOTN 
Inquiry Number from the table under “Touchscreen Settings.” 

o In this example, 1021 – SIM 6 – CaDOTN - Inq 2. 

• Click OK to close the window. 

6. Click  to save the settings. 

7. Repeat Steps 1, 2, 3, 4, 5, and 6 for all gift card buttons that need to be added and configured according to 
your newly configured settings in the MICROS 9700 system. 

8. Repeat all sections in “Configuring the Touchscreen” to configure additional Touchscreens (if gift card 
buttons exist on other screens, other than Payment) for the selected revenue center. This is required to 
ensure the system is completely functional. After all touchscreens are configured for the selected revenue 
center, proceed to Step 9. 

9. Repeat all sections in “Touchscreen Settings” if additional revenue centers need to be configured. 
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Parameter File Settings 
The CaDOTN.param file must be updated to reflect your newly configured gift card settings in the MICROS 9700 
system to support Secure Suite 4 MICROS 9700. To update the parameter file, perform the following steps: 

1. Navigate to …\MICROS\LES\POS\9700\Etc and open CaDOTN.param in WordPad or Notepad. 

2. Continue to “Updating the Manager Auto Activate and Alternate GC Preamble Parameter.” 

Updating the Manager Auto Activate and Alternate GC Preamble Parameter 
1. Locate the Manager Auto Activate and Alternate GC Preamble Section: 

 

 
 

 

Tip: Search the document for key words to locate the sections quickly. 
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2. Update the Manager Auto Activate and Alternate GC Preamble Parameter according to your newly 
configured settings in the MICROS 9700 system by typing the applicable Required Setting from the table 
below: 

 

Manager Auto Activate and 
Alternate GC Preamble 

Parameter 
Required Setting Notes 

var ManagerAutoActivate 
Y – Enabled 

N – Disabled 

If the GC Activate and GC Deactivate 
functions require manager approval, set to 

Y to enable. If they do not, set to N to 
disable. 

 

For SAR terminals, if GC Activate and GC 
Deactivate are in use, ManagerAutoActivate 

must be set to Y or there will be a Not 
Supported error. 

var AltGCPreamble 

If gift cards have a zero 
preamble: a7 = "" 

 

If gift cards have an alternate 
preamble (anything other than 

zero): a7 = "nnnnnn" 

Where nnnnnn is the alternate 
preamble. 

Type only the numbers of the non-zero gift 
card preamble. 

  

DO NOT type the asterisk (*) symbol, which 
indicates additional numbers outside the 

preamble range. 

 

3. Save the CaDOTN.param file but do not close it. 

4. Continue to “Updating the Tender Keys Parameters.” 



 Secure Suite 4 MICROS 9700 Version 3 
Technical Installation Guide 

© 2019 Shift4 Payments, LLC. All rights reserved. Version 1.7 
External Use NDA Page 116 of 130 

Updating the Tender Keys Parameters 
1. Locate the Tender Keys section: 

 

 
 

2. Update the Tender Keys Parameters according to your newly configured settings in the MICROS 9700 
system by typing the applicable Required Setting from the table below: 

 

Tender Keys Parameter Tender Media/Service Charge 
Name Required Setting 

var YC_TENDER Gift Card 

If in use: (7,#) where # is the Tender Media 
Number recorded on your reference list. 

 

If not in use: (7,999). 

var GCSALE_SVC_OBJ GC SALE If in use: (5,#) where # is the Gift Card 
Service Charge Number recorded on your 

reference list. 

 

 If not in use: (5,999) 

var GCCASH_SVC_OBJ GC CASHOUT 

var GCRCHG_SVC_OBJ GC RECHARGE 

 

3. Save the CaDOTN.param file but do not close it. 

4. Continue to “Updating the Manager Groups Parameters.” 
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Updating Manager Groups Parameters 
1. Locate the Manager Groups section: 

 

 
 

2. Update the Manager Groups Parameters according to your newly configured settings in the MICROS 9700 
system by typing the applicable Required Setting from the table below: 

 

Manager Groups 
Parameter Required Setting 

var mgrpcount : n4 = # 
# equals the total number of MICROS Employee Classes that require gift card 

permissions. 
var managergroups [#]: a10 

managergroups [x] =  "n" 

x will begin with 1 and increment by one for each additional Manager Group 
Parameter added to represent a MICROS Employee Class Number. 

 

n equals the MICROS Employee Class Number recorded on your reference list and 
typed within double quotes. 

 

3. If needed, to add additional manager groups to the CaDOTN.param file: 

• Copy the last block of managergroups [x] =  "n" parameter content. 
• Paste the copied selection below the last block of managergroups [x] =  "n" parameter 

content. 

• In the pasted content, increment x by one.  
• In the pasted content, replace n with the MICROS Employee Class Number recorded on your 

reference list and typed within double quotes. 

4. Save the CaDOTN.param file but do not close it. 

5. Continue to “Updating Log and Operation Parameters.”  
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Updating Log and Operation Parameters 
1. Locate the Log and Operation section: 

 

 
 

2. Update the Log and Operation Parameters according to your newly configured settings in the MICROS 
9700 system by typing the applicable Required Setting from the table below: 

 

Log and Operation 
Parameter Required Setting Notes 

*alt_gc_preamble 

If gift cards have a zero preamble: 
"" 

 

If gift cards have an alternate 
preamble (anything other than 

zero): "nnnnnn" 

Where nnnnnn is the alternate 
preamble.  

Type only the numbers of the non-zero gift card 
preamble. 

  

DO NOT type the asterisk (*) symbol, which indicates 
additional numbers outside the preamble range. 
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Log and Operation 
Parameter Required Setting Notes 

*gc_sim_partialauth 0 – This parameter has been 
deprecated. 

If a gift card with insufficient funds is used it will be 
declined and the error message will state the 
available balance. Then, the clerk can use the 

available gift card balance with a new authorization 
and collect for the remaining balance. 

 

3. Save and Close the CaDOTN.param file. 

4. Continue to “Rebuilding the CaDOTN.dat File.” 

 

Rebuilding the CaDOTN.dat File 
If the MICROS 9700 system is being upgraded from Shift4 Payments’ Enhanced driver, after editing the 
CaDOTN.param file, you must delete the CaDOTN.dat file. This ensures the MICROS 9700 system rebuilds the 
CaDOTN.dat file using the updated CaDOTN.param file once it is restarted. To delete the CaDOTN.dat file, perform 
the following steps: 

1. Navigate to ...MICROS\LES\POS\9700\etc. 

2. Locate CaDOTN.dat, right-click and select Delete. 

 

Replacing the CaDOTN.param File 
After editing and saving the changes made to the CaDOTN.param file, replace the old CaDOTN.param file in the 
following directories on the server with the new version: 

 

\MICROS\LES\POS\9700\ClientInstalls\CALInstall\Win32\Files\Shift4\Param 

\MICROS\LES\POS\9700\ClientInstalls\CALInstall\WS4\Files\CF\PosClient\Sim 

\MICROS\LES\POS\9700\ClientInstalls\CALInstall\WS4LX\Files\CF\PosClient\Sim 

\MICROS\LES\POS\9700\ClientInstalls\CALInstall\WS5\Files\CF\PosClient\Sim 

\MICROS\LES\POS\9700\ClientInstalls\CALInstall\WS5A\Files\CF\PosClient\Sim 
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Post-Installation Process 
After you install and configure Secure Suite 4 MICROS 9700 and the optional, advanced configuration (gift card), 
test the MICROS 9700 system thoroughly using the processes outlined in this section. 

 

Restarting the MICROS 9700 System 
After installing and configuring Secure Suite 4 MICROS 9700, the MICROS 9700 system must be restarted for the 
changes to take effect. To restart the MICROS 9700 system, perform the following steps: 

1. In the EMC window, under SYSTEM, select Control Panel. 

2. On the Control Panel tab, verify Down is selected. If not, configure the following: 

 

 
 

• Under Control, select Down. 
• When the system prompts Stop the 9700 system? click Yes. 
• Under Message, verify Stopped System appears. 
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3. On the Control Panel tab, configure the following: 

 

 
 

• Under Control, select Server Applications which restarts the system without activating the 
terminals. 

• Under Message, verify Server Applications started appears. 
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Verifying the CaDOTN.log File 
To verify the operational status of the system, perform the following steps: 

1. Navigate to …\MICROS\LES\POS\9700\Log. 

2. Locate CaDOTN.log and open the file in WordPad or Notepad. 

3. Verify Hello Micros, I’m listening appears in the log which indicates Secure Suite 4 MICROS 9700 is 
operating. 

 

 
 

 

Requirement: If Hello Micros, I’m listening is not displayed, contact Shift4 
Payments Customer Support. 
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Activating the MICROS Terminals 
After restarting the MICROS system and verifying the operational status of the system, the terminals must be 
activated. To activate the terminals, perform the following steps: 

1. On the Control Panel tab, configure the following: 

 

 
 

• Under Control, select Workstation Operations. 

• Under Message, verify Operations started appears. 

2. Close the Control Panel tab. 

 

Running a Test Transaction 
To test Secure Suite 4 MICROS 9700, perform the following steps: 

1. Run a test credit authorization, and finalize it as you normally would finalize a real transaction. 

2. In Lighthouse Transaction Manager, confirm that test transaction came through the right merchant. 

3. In Lighthouse Transaction Manager, confirm settlement of the test transaction. 

4. If you did not set up the advanced configuration option (gift card), and your test transaction was 
successful, configuration, verification, and testing of Secure Suite 4 MICROS 9700 is complete, 
congratulations! 

5. If you did set up the advanced configuration, repeat the steps above to complete the verification and 
testing of Secure Suite 4 MICROS 9700 for gift card configuration. 
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Appendix A - Troubleshooting 
Appendix A contains troubleshooting information for Secure Suite 4 MICROS 9700 when in use. Due to the 
complexity of the environment that Secure Suite 4 MICROS 9700 operates in, it may be necessary to take a closer 
look at the system and the configuration to restore full functionality of the implementation.  

Log and Trace File Locations 
Both the log and trace files contain information about the system that is helpful for troubleshooting. 

 

The Support department may have you change settings to reveal more detailed information – refer to these 
sections in the document: Parameter File Settings, Updating the Log and Operation Parameters and Replacing the 
CaDOTN.param File to ensure the requested changes take effect. 

Logs 
The default locations for the log and trace files are: 

• [Drive Letter]:\Micros\Les\Pos\9700\Log\8700d.log 
• [Drive Letter]:\Micros\Les\Pos\9700\Log\CaDOTN.log 

If the logs are not in the default location, search the MICROS server for the files by name. Both log files should be 
in the same directory on the computer. 

 

Trace Files 
The default location of the UTG trace files is: 

• C:\Shift4\UTG\Trace\Unnnn.TRC on the Shift4 server, where nnnn is an automatically incremented 
number that uniquely identifies the trace. Examples: U9259.TRC and U9260.TRC. 

 

If the UTG trace logs are not in the default location, then the UTG has been configured to write them to a different 
directory and, possibly, a different file name.  

 

To determine the directory and file name of the UTG trace logs, perform the following steps: 

1. If the UTG is running as a service, stop the service: 

• From the Start menu, select Programs > Administrative Tools > Services. 
• Locate Shift4 UTG(v2), right-click and select Stop. 

2. If the UTG is running in Stand Alone, close it: 

• In the UTG Task Explorer window, click Close (red X). 
• On the Shutdown Shift4’s Universal Transaction Gateway screen, select Yes. 
• The UTG Task Explorer window will show a shutdown countdown and then close. 
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3. From the Start menu, select Programs > Shift4 Corporation > Universal Transaction Gateway > UTG (v2) 
Tune Up. 
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4. In the UTG TuneUp window, click the Advanced tab and then click the Trace Configuration button. 

5. In the Trace Parameters window, the Directory box shows the path where the UTG trace files are located, 
and the Suffix box contains an optional suffix appended to the default file name. 

6. Restart the UTG service: 

• As a service, from the Start menu, select Programs > Administrative Tools > Services. Locate 
Shift4 UTG(v2), right-click and select Start. 

• In Stand Alone, from the Start menu, select Programs > Shift4 Corporation > Universal 
Transaction Gateway > UTG (v2) Stand Alone.  
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Payment Card Verification 
Any time a clerk swipes a payment card on the terminal, Secure Suite 4 MICROS will compare the last payment 
card used to the payment card that was currently swiped. 

 

If the payment card numbers are the same, Secure Suite 4 MICROS will instruct the clerk to enter the last four 
digits of the payment card that was currently swiped in order to verify the use of the same payment card: 

 

 
 

If the payment card numbers match, the transaction will process normally. If the payment card numbers do not 
match, Secure Suite 4 MICROS will prompt the clerk to swipe the customer’s payment card again, and then the 
transaction will process normally: 
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Resolving Issues and Errors 
When errors and/or issues occur, document them accordingly.  

   

 

Requirement: Have the clerk leave the screen up and call or contact the 
manager on duty. 

 

In order to troubleshoot efficiently, it is important to gather the following data: 

• The exact version of MICROS (for example, 9700 3.6) or build. 
• The terminal type (Workstation 4, 5, Eclipse with HDD, etc.). 

• What action the clerk was attempting when the error occurred (cc auth, cc close etc.). 
• The date and time that the error occurred and the immediate action the clerk took prior to the error 

(immediately after swiping, after entering CVV2 code, etc.) 

• CC info (type of card, last 4 numbers, and amount). 
• The exact error description (if any). 
• The exact terminal/server on which the error happened. 
• Trends (issue occurs at a specific time, only on certain card types, when the Internet is down, on all 

workstations or a certain workstation, etc.). 

After verifying the workstation, perform the following steps on the server: 

1. Verify the status of the MICROS system by bringing up the MICROS Control Panel. 

2. Document any errors showing on the server. 

3. Right-click the clock in the bottom right corner of the screen and select Task Manager.  

4. Click the Processes tab and verify (and document) ccs.exe and caDOTN.exe are listed. 

After documenting all of the above information, and prior to restarting the system, make copies of the following 
files, and email them to trace@shift4.com together with all of the gathered information: 

• [Drive Letter]:\Micros\Res\Pos\Etc\9700d.log 
• [Drive Letter]:\Micros\Res\Pos\Etc\CaDOTN.log 
• The four most recent Shift4 trace files (normally located under C:\Shift4\UTG\Trace on the Shift4 server). 

Examples: U9259.TRC and U9260.TRC  

Refer to the Log and Trace File Locations section for information about where to find these files on the Shift4 
server and include your Shift4 Payments/DOTN serial/account number and the name of your establishment in your 
email message. 

Calling for Technical Support 
Immediately after completing the data gathering steps, call the Support department at 702.597.2480, option 2, to 
open a case. The Support Representative will have the issue resolved as quickly as possible.  
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Appendix B – Additional Resources 
Appendix B contains a list of additional resources that may be helpful and provide additional guidance when 
installing and configuring Secure Suite 4 MICROS 9700. Direct any specific questions about these documents to 
their respective publishers. 

Product Support 
For assistance with this and any other Shift4 Payments product, visit the website at www.shift4.com. It provides 
access to the FAQ page (under Client Center), where answers to general and technical questions regarding the 
entire Shift4 Payments product line are available. 

Live Support 
Information about troubleshooting techniques and handling special problems that may occur during installation or 
configuration can be obtained by contacting the Shift4 Payments Customer Support team at 702.597.2480, option 
2. 

On the Web 
The Shift4 Payments website at www.shift4.com offers technical notes, patches, and guides 24 hours a day, 7 days 
a week, 365 days a year. The Shift4 Payments website also contains troubleshooting and FAQ sections to provide 
additional guidance. 

Feedback 
Your feedback regarding Shift4 Payments products and documentation is welcome, encouraged, and we 
appreciate your comments. If you have any documentation comments or suggestions about this guide, please send 
them to us at techdocs@shift4.com. 

Shift4 Payments Guides and Documentation 
The following Shift4 Payments guides and documentation may provide additional helpful information: 

• UTG Quick Installation Guide 

• UTG Using External Devices Guide 

MICROS Manuals 
Refer to the following MICROS manual for additional manufacturer information: 

• MICROS Systems, Inc. User’s Manual for MICROS 9700 POS Systems 

MICROS Customer Support 
MICROS Customer Support can be reached by phone or email: 

• For technical assistance, 800.937.2211. 
• For product inquiries, 866.287.4736. 
• To contact via email, info@micros.com. 

http://www.shift4.com/
http://www.shift4.com/
mailto:techdocs@shift4.com?subject=Shift4%20Documentation
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Industry Websites 
The following sites provide additional industry guidelines and standards: 

• https://www.pcisecuritystandards.org/  
• http://usa.visa.com/merchants/risk_management/index.html 
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